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Micro FocusCOBOL Server 2.2 Update 2
Release Notes

These release notes contain information that might not appear in the Help. Read them in their entirety
before you install the product.

Note: This document contains a number of links to external Web sites. Micro Focus cannot be
responsible for the contents of the Web site or for the contents of any site to which it might link. Web
sites by their nature can change very rapidly and although we try to keep our links up-to-date, we
cannot guarantee that they will always work as expected.

These release notes include information about the Release 2 installers for COBOL Server 2.2 Update 2
which include fixes up to HotFix 6 of the 2.2 Update 2 release. The Release 2 installers replace the GA
installers of COBOL Server and include any fixes delivered with HotFixes 1 to 6 of 2.2 Update 2. See
Deployment to Windows XP and Windows Server 2003 in the New Features section for more information.

COBOL Server Variants and Deploying Applications

Visual COBOL is available in different IDE variants, each one of which is targeted by one specific variant of
the development product:

• COBOL Server - the deployment environment for COBOL applications created with Visual COBOL for
Visual Studio 2010 or Visual COBOL for Eclipse

• COBOL Server 2012 - the deployment environment for COBOL applications created with Visual COBOL
for Visual Studio 2012

• COBOL Server 2013 - the deployment environment for COBOL applications created with Visual COBOL
for Visual Studio 2013

You can install and use all COBOL Server variants with the same license.

You can only deploy applications to the specific variant of COBOL Server that is targeted by the Visual
COBOL variant used to build the applications. For example, if you build your application using Visual
COBOL for Visual Studio 2012, you can only deploy the target files to COBOL Server 2012. The
application will not run in COBOL Server or COBOL Server 2013.

Micro Focus Heartbleed Update

The OpenSSL library used in this product has been updated to the latest version, 1.0.1i, to fix various
vulnerabilities.

Note: Visual COBOL now includes support for creating Web service and Enterprise Java Bean
applications using the Interface Mapping Toolkit (IMTK) in conjunction with Enterprise Server. If you
are upgrading to this release from an earlier version of Visual COBOL, you may need to apply for a
new authorization code in order to access the functionality - please contact Micro Focus SupportLine
to receive an updated authorization code. Note that the Visual COBOL Personal Edition license does
not support the IMTK functionality.
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Installation

Installing on Windows

System Requirements for COBOL Server for Windows

Hardware Requirements
The disk space requirements are approximately:

Platform COBOL Server Sentinel RMS License Manager

x86 Windows platforms 100MB 25MB

x64 Windows platforms 200MB 25MB

Note: This includes the space needed to cache information locally so that you can modify the
installation without the original source media.

Operating Systems Supported
The following platforms are supported:

For a list of the supported operating systems, check the Product Availability section on the Micro Focus
SupportLine Web site: http://supportline.microfocus.com/prodavail.aspx.

Note:

• The Enterprise Server feature is not supported on Windows XP or Windows Server 2003.

Software Requirements
Note: The setup file will check your machine for whether the prerequisite software is installed and will
install any missing prerequisites and the product components.

Before installing this product, you must have the following software installed on your computer:

• On Windows Server 2003, you must have Microsoft's Windows Imaging Components (WIC) installed
before you start installing COBOL Server.

Download the 32-bit version of WIC from http://www.microfocus.com/docs/links.asp?vc=wic and the 64-
bit version - from http://www.microfocus.com/docs/links.asp?vc=wic64.

• The Microsoft .NET Framework - the setup file installs Microsoft .NET Framework 4 with COBOL
Server, .NET Framework 4.5 with COBOL Server 2012, or .NET Framework 4.5.1 with COBOL Server
2013. You might need to install the following version of the .NET framework manually, if it is targeted by
your applications:

• Microsoft .NET Framework 2 - if your applications use the ILCLR(2) Compiler Directive or if they
target the .NET Framework versions 2, 3 or 3.5. You might need to download these installers
depending on the .NET Framework you are targeting.

To download the Microsoft .NET Framework 2 click here.

Microsoft .NET Framework 2 or later is also required for the Micro Focus License Manager if you
install this on a separate machine as a license server.
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• Microsoft .NET Framework 4.5 might be required for COBOL applications created with Visual Studio
2012.

• Microsoft .NET Framework 4.5.1 might be required for COBOL applications created with Visual
Studio 2013.

Note:

• .NET Framework 3 is provided with Windows Vista and Windows Server 2008.
• .NET Framework 3.5 is provided with Windows 7 and Windows Server 2008 R2.
• .NET Framework 4.0 is provided with Windows 7 and Windows Server 2008 R2.
• .NET Framework 4.5 is provided with Windows 8 and Windows Server 2012.
• .NET Framework 4.5.1 is provided with Windows 8.1 and Windows Server 2012 R2.

• Microsoft's Web Platform Installer 2.0 if your application targets ASP.NET 4. This installs and sets up
ASP.NET. To download the installer click here.

• A Web browser is required for Enterprise Server Administration in COBOL Server.

To use your Web browser offline, you need the dial-up networking feature of Windows installed.
Otherwise you might have TCP/IP errors such as being unable find "localhost" or the numeric equivalent
(127.0.0.1).

• To use Enterprise Server Administration, scripting or JavaScript support must be enabled in your
browser. This is on by default in Internet Explorer in most Windows operating systems, apart from
Windows Server 2003. Also, active content must be allowed and not blocked. To enable both these in
Internet Explorer:

1. Click Tools > Internet Options.
2. On the Security tab, click Custom Level. In the Scripting section, under Active Scripting, click

Enable.
3. On the Advanced tab, scroll down the list to the Security section, and ensure the item Allow active

content to run in files on My Computer is checked.
• Enterprise Server Help requires the Java Runtime Environment on some Windows systems to enable

the Search facility to work.

Important: This release requires version 10000.2.990 or later of the Micro Focus licensing software.
For local servers, you do not need to install it separately, as the setup file installs a new Visual
COBOL client and a new licensing server on the same machine.

If you have a network server, you must update the license server before installing the product as the
client is not able to communicate with license servers of versions older than 10000.2.660. On
Windows, you can check the version of your license server by clicking Help > About in the Micro
Focus Licensing System Administration tool. To check the version of the license server on UNIX,
run /var/microfocuslicensing/bin/mfcesver or /var/microfocuslicensing/bin/
cesadmintool.sh.

You can download the new version of the license server software from the Micro Focus SupportLine
Web site: http://supportline.microfocus.com.

Additional Software Requirements
To ensure full functionality for some COBOL Server features, you might be required to obtain and install
additional third-party software in addition to the prerequisite software installed automatically by the COBOL
Server setup file. The following information specifies the third-party software required for each feature.

• Application server support for JVM COBOL on page 7
• Consolidated Trace Facility on page 7
• Database Access on page 7
• XML Extensions on page 7
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Application server support for JVM COBOL

Back to Top

Restriction: This feature applies only when the Enterprise Server feature is enabled.

The following application servers are supported using the following JDKs:

Application Servers JDK version Containers support version

Tomcat 7.0.39 1.6 / 1.7 Servlets 2.5

JBoss 7.1.1 1.6 / 1.7 Servlets 2.5

WebLogic 12.1.1 1.6 / 1.7 Servlets 2.5

WebSphere 8.5 1.6 / 1.7 Servlets 2.5

You need Oracle's JDK. The earliest supported release of Oracle's JDK 1.6 is 1.6.027. You can download
Oracle's JDK from Oracle's Web site

Back to Top

Consolidated Trace Facility

• The Microsoft .NET Framework 2.0 or later is required for the CTF Viewer. It is available from the
Microsoft .NET downloads area.

Database Access

Back to Top

Before you can use COBOL Server to deploy SQL applications developed with OpenESQL, DB2 ECM, or
COBSQL, ensure any third-party software prerequisites are installed and the environment is set properly.
Refer to the your product help, Welcome > Product Information > Installing... > System
Requirements... > Additional Software Requirements > Database Access, for details.

XML Extensions

Back to Top

• XML Extensions has the same requirements as Visual COBOL. Both 32-bit and 64-bit versions are
available. See the XML Extensions for Visual COBOL, available from the Visual COBOL product
documentation section of the Micro Focus SupportLine Web site for more details.

• Additionally, XML Extensions may be used in conjunction with Terminal Server.

Installing COBOL Server for Windows

Downloading the Product
1. Use the download links in your Electronic Product Delivery email.

For more information follow the links for the installation instructions and the End User License
Agreement.

Product Co-Existence
• Visual COBOL is available in different IDE variants, each one of which is targeted by one specific

variant of the development product:

• COBOL Server - the deployment environment for COBOL applications created with Visual COBOL
for Visual Studio 2010 or Visual COBOL for Eclipse
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• COBOL Server 2012 - the deployment environment for COBOL applications created with Visual
COBOL for Visual Studio 2012

• COBOL Server 2013 - the deployment environment for COBOL applications created with Visual
COBOL for Visual Studio 2013

• COBOL Server 2010, COBOL Server 2012 and COBOL Server 2013 cannot coexist on the same
machine.

Installation Restrictions and Requirements
Before starting the installation, you should consider the following:

• If you are installing this as an upgrade, make sure that none of the product files are in use when you
start the installation.

• You need to be logged in with a user-ID that has write access to the registry structure under
HKEY_LOCAL_MACHINE, HKEY_CLASSES_ROOT, and HKEY_CURRENT_USER so the installation
software can set the environment appropriately. You also need to be logged on with Administrator
privileges.

• Before installing this product, make sure that any existing Micro Focus Directory Server (MFDS) or
CCITCP2 Windows service (on Windows) or a process (on UNIX) from an existing product is stopped
and uninstalled. On Windows, do this as follows:

1. Stop the MFDS and CCITCP2, using either the Windows Service Management Console GUI
(services.msc) or from a command line prompt by typing:

net stop mf_ccitcp2

Only one instance of the MFDS or CCITCP2 service can run on a Windows machine.
2. Uninstall the MFDS or CCITCP2 service.

For MFDS, from a command line prompt enter: mfds -u

For CCITCP2: ccitcp2 -u

To run an earlier version of MFDS as a service after you have installed a later version:

1. Stop and uninstall the MFDS service, as described above.
2. Reinstall the earlier version, as follows:

a. Open a  COBOL Server command prompt.
b. Install the service. Enter the following command: mfds -i
c. Start the service. Enter the following command: net start mf_ccitcp2

Note: The two versions use different paths for environment and registry values, so the list of
configured enterprise servers might be different depending on which version has been started,
since, by default, different MFDS data repositories are used.

MFDS 5.1 and later are able to import or use Enterprise Server configuration data generated by earlier
versions of MFDS, but 5.0 or earlier versions of MFDS might not be able to read data generated by later
versions.

It is possible to run MFDS from a command prompt ("mfds") rather than as a service, but by default the
"mfcobol" port is used (86) and this can only be used by one process at a time

Installing as an Upgrade
This release will update an existing installation of COBOL Server 2.2.

Important:
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• Before installing this release as an upgrade to an existing installation of the previous version 2.2 of
the product, you must uninstall any HotFixes of 2.2. This is to avoid some problems that might
result in files not being installed.

• Before installing this release as an upgrade, ensure you create a back-up of your Enterprise
Server configuration. To do this, on the Enterprise Server Administration home page, click Export
and then select Export Enterprise Server configuration and Security Manager definitions.
This creates a backup folder in the c:\programdata\micro focus\Enterprise
Developer\MFDS. You can restore the Enterprise Server configuration after installing this release
- click Import on the Enterprise Server Administration home page.

Before installing, check Installation Restrictions and Requirements.

Installing
Note: See Installing as an Upgrade first for important information when upgrading an existing
installation of COBOL Server.

These are the steps to install this product:

1. Run the cs2010_222_r2.exe file and follow the wizard instructions to install the prerequisite software
and the product.

The setup file will also install any missing prerequisite software as listed in the topic Software
Requirements.

Note: The respective installation files for COBOL Server 2012 and COBOL Server 2013 are
cs2012_222_r2.exe and cs2013_222_r2.exe.

r2 stands for Release 2 of version 2.2 Update 2 of COBOL Server. The r2 installers are provided
with HotFix 6 of 2.2 Update 2 and enable you to install COBOL Server 2012 and COBOL Server 2013
on Microsoft's Windows XP and Windows 2003 platforms for the deployment of native and managed
COBOL applications. Note that SOA functionality is not supported on these platforms. See New
Features for more details.

Note:

• If you are installing onto a machine that has an existing Micro Focus product that uses an older
Sentinel RMS License Manager, you might be prompted to remove it and install the Micro Focus
License Administration. By doing this you maintain the existing Sentinel RMS license files while
adding the Micro Focus License Administration. If you are unsure about existing licenses on your
computer or removing the Sentinel RMS License Manager, consult your System Administrator. If
you want to proceed, remove Sentinel RMS License Manager by using Add or Remove
Programs (Windows XP) or Program and Features (Windows Vista or later), and rerun the
installation file.

• Trial licenses cannot be used with remote desktop services. If you want to use your product in this
way, please contact Micro Focus SupportLine to obtain a relevant license.

• We recommend that you install any updates for the .NET Framework that are available at the 
Microsoft Download site.

• If you install JDK you might be prompted to install the latest update. The latest update is not
required for use with COBOL Server but you can install it if you wish.

COBOL Server Installation Options
To install COBOL Server you run cs2010_222_r2.exe which contains a number of product .msi files
(Windows Installer packages). When run, cs2010_222_r2.exe performs some initial system checks then
sequentially installs the .msi files.

Note: This document only uses the filename of the executable for the product variant you have
installed - cs2010_release.exe. For COBOL Server 2012, the filename is cs2012_222_r2.exe,
and for COBOL Server 2013 - the filename is cs2013_222_r2.exe.
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cs2010_222_r2.exe can take a number of parameters, enabling you to specify a number of different
types of installation:

• Standard Installation

Format:
cs2010_222_r2.exe

Summary:
Full installation including License Manager and COBOL Server. During installation you can specify
options including the location to which the components are installed.

• Non-interactive Installation

Format:
cs2010_222_r2.exe /passive

Summary:
Full installation, but the components are installed non-interactively using default options and
directories.

• Silent Installation

Format:
cs2010_222_r2.exe /q

Summary:
Full installation, but the components are installed non-interactively with no user interface, using
default options and directories.

• Modified Silent Installation

Format:
cs2010_222_r2.exe /q InstallFolder=d:\cobolrts

Summary:
Full installation, but the components are installed non-interactively with no user interface, and
COBOL Server is installed to d:\cobolrts.

To see what parameters you can use, execute the following from the command line:
cs2010_222_r2.exe /?.

Note:

• Log files that are created during installation are saved in the folder specified by the TEMP
environment variable. To change the location or name of the files, use the /log parameter on your
setup command line and specify the path and file name, for example: filename /log d:\temp
\log.txt. This creates a log file, named log.txt, in the d:\temp directory.

After Installing
To open the help on versions of Windows 7 and earlier, select Start > All Programs > Micro Focus
COBOL Server > Documentation from the Windows Taskbar.

On Windows 8, right-click at the bottom of the Start screen, and click All apps to display all available links
for this product. In the COBOL Server section, click Documentation.

This starts the documentation for COBOL Server in the online Micro Focus Infocenter. From the left hand
pane, select Micro Focus Developer > Micro Focus COBOL Server.

Note: For applications created with earlier Micro Focus products or earlier versions of Visual COBOL,
note the following:
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Database Access Managed applications using SQL(DBMAN=ODBC) that were compiled in
Visual COBOL 2.1 Update 1 must be recompiled in Visual COBOL 2.2 Update
2.

Existing
Applications

Application executables that were compiled using earlier Micro Focus products
must be recompiled from the sources using Visual COBOL.

Open PL/I
Compiler

Important: If you are installing this release as an upgrade to Enterprise
Developer 2.2 Update 1, after the upgrade you must rebuild any applications that
are compiled using the –zp1 option.

The behavior of the –zp1 option has been reverted to that of versions of Enterprise
Developer earlier than 2.2 Update 1, with an additional correction relating to Char
Varying data items.

The behavior has been restored to that in Enterprise Developer versions earlier than
2.2 where, when compiling with –zp1, all parameters are treated as unaligned. (In
Enterprise Developer 2.2 Update 1, the behavior when compiling with –zp1 was to not
treat parameters as if unaligned).

When using the –zp1 compiler option, all Character Varying data items are now treated
as if unaligned. In previous versions of Open PL/I, for Character Varying data items,
the –zp1 unaligned requirement was applied only to structure members and
parameters.

To illustrate the change, consider the following example:

zptest: proc options(main); 
 
   dcl 1 st1, 
     2 c char, 
     2 x(4) char(7) var init ('a', 'xx', 'yyy', 'zzzz'); 
 
   dcl y(4) char(7) var init ('a', 'xx', 'yyy', 'zzzz'); 
 
   dcl sub entry ((4) char(7) var); 
 
   call sub (x); 
 
   call sub (y); 
 
end; 
 
sub: proc (z); 
 
   dcl z(4) char(7) var; 
 
   dcl i fixed bin(31); 
 
  do i = 1 to hbound(z); 
      z(i)  = 'x'; 
  end; 
 
end; 

Where:

• For x and z, each char (7) var item is 7 plus 2 bytes which equals 9 and then
multiplied by 4 equals 36.

• If y were aligned on half-word by default, each array element is half-word aligned
and each equals 10 bytes (9 + 1 pad byte), and the total size equals 40 bytes.

• At call sub (x), the calling argument and parameter are matched.
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• At the call sub (y), the y element size (10 bytes) is mismatched against the
parameter z element size (9 bytes) due to –zp1. This is incorrect and causes
unexpected program behavior.

Due to this correction of treating all Char Varying data items as if unaligned when using
–zp1, the size of CHAR VARYING arrays now differs from previous versions of Open-
PL/I. For example:

   dcl X(4) char(7) var; 
 
   Put skip list (size(X))  /* size is 36 bytes vs. 40 bytes in 
previous versions of Open-PL1 */ 

Repairing
If any product files, registry settings or shortcuts are accidentally removed at any point, you can perform a
repair on the installation to replace them.

To repair your installation on versions of Windows Vista or later:

1. From the Control Panel, click Uninstall a program under Programs.
2. Right-click your Micro Focus product and select Repair.

To repair your installation on older versions of Windows, such as Windows XP:

1. Click Start Menu > Control Panel > Add/Remove Programs.
2. Click your Micro Focus product in the list of installed programs.
3. Click Click here for support information.
4. Click Repair.

Uninstalling
To uninstall the product, you cannot simply delete its files from your hard disk. To uninstall the product:

1. Log in with the same user-ID as you used when you installed the product.
2. Click Uninstall a program under Programs (or Add/Remove Programs on older versions of

Windows) in Control Panel.
3. On older versions of Windows such as Windows XP, ensure that Show Updates (at the top of the Add

or Remove Programs dialog) is checked, so that any hot fixes or WrapPacks are listed.
4. Select the product and click Remove or Uninstall as appropriate.

When you uninstall, the only files deleted are those that the installation software installed. If the product
directory has not been removed, delete any unwanted files and subdirectories within it using Windows
Explorer.

Important: The installer creates separate installations for Micro Focus COBOL Server and Micro
Focus License Administration. Uninstalling only COBOL Server does not automatically uninstall the
Micro Focus License Administration or any of the prerequisite software.

To completely remove the product you must uninstall the Micro Focus License Administration as well.

You can optionally remove the prerequisite software. For instructions, check the documentation of the
respective software vendor.

To silently uninstall the product, you need the setup file and you need to execute the following at the
command line:

start /wait install-file.exe /quiet /uninstall
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Installing on UNIX

System Requirements for COBOL Server for UNIX

Hardware Requirements for COBOL Server
The disk space requirements are approximately:

Platform Setup

file size

(MB)

Disk space

required for

the installation

(GB)

Disk space

required for

running

the product

(MB)

Sentinel RMS

license server

(MB)

POWER running AIX 296 1.18 592 33

HP IA 619 2.48 1240 61

System Z running
Red Hat Linux

254 1.02 508 34

x86-64 running Red
Hat Linux

263 1.05 526 40

SPARC running
Solaris

308 1.23 616 38

x86-64 running
Solaris

284 1.14 568 30

System Z running
SuSE SLES

257 1.03 514 34

x86-64 running SuSE
SLES

266 1.06 532 40

Operating Systems Supported
For a list of the supported operating systems, check the Product Availability section on the Micro Focus
SupportLine Web site: http://supportline.microfocus.com/prodavail.aspx.

Software Requirements
Before installing this product, you must have the following software installed on your computer:

• The pax archiving utility is required by the setup file. Pax is distributed with most UNIX/Linux systems
but, if it is missing, you must install it separately. To verify pax is installed, run pax --help or pax --
version at the command line.

• On Red Hat 6.x and Red Hat 7, you must have the following operating system libraries installed:

glibc-*.x86_64
glibc-*.i686
libgcc-*.x86_64
libgcc-*.i686
libstdc++-*.x86_64
libstdc++-*.i686

In addition, on IBM System z (390), you must have the following operating system libraries installed:
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glibc-*.s390
glibc-*.s390x
libgcc-*.s390
libgcc-*.s390x

Additional libraries for HCO for SQL Server Tools
glibc-devel-*.s390
glibc-devel-*.s390x

Visit the Red Hat Web site for more information.

• Oracle's Java Platform, Enterprise Edition (Java EE) 6 or Java 7 is required to execute COBOL JVM
code and for native COBOL and Java interoperability. The earliest supported release of Java 6 is 1.6
Update 27. You can download Oracle's Java EE from Oracle's Web site and install it anywhere on your
machine.

Note:

• On AIX and zLinux, you need to have IBM's JDK. The earliest supported release of IBM's JDK
1.6 is 1.6.0.13. You can get IBM's AIX JDK from IBM's Web site.

• On HP-UX, you need to have HP-UX JDK. The earliest supported release of HP-UX JDL 1.6 is
Java 6.0.13. You can get the HP-UX Java JDK from HP's Web site.

Before you start the installation, you need to set the environment as follows:

• You need to set the LANG environment variable to pick up localized messages. The LANG settings are
English and Japanese only.

• The Java Development Kit (JDK) is required for compiling Java. The JDK is downloadable from 
www.oracle.com. After installing the JDK, you must put the tools.jar file for the JDK on your classpath,
using a command similar to:

 set classpath=jdk-install-directory\lib\tools.jar

• JavaScript or scripting support must be enabled in your browser, so that Enterprise Server
Administration is usable. Also, active content must be allowed and not blocked.

Important: This release requires version 10000.2.990 or later of the Micro Focus licensing software.
For local servers, you do not need to install it separately, as the setup file installs a new Visual
COBOL client and a new licensing server on the same machine.

If you have a network server, you must update the license server before installing the product as the
client is not able to communicate with license servers of versions older than 10000.2.660. On
Windows, you can check the version of your license server by clicking Help > About in the Micro
Focus Licensing System Administration tool. To check the version of the license server on UNIX,
run /var/microfocuslicensing/bin/mfcesver or /var/microfocuslicensing/bin/
cesadmintool.sh.

You can download the new version of the license server software from the Micro Focus SupportLine
Web site: http://supportline.microfocus.com.

Additional Software Requirements on Linux and UNIX
To ensure full functionality for some COBOL Server features, you might be required to obtain and install
additional third-party software in addition to the prerequisite software installed automatically by the COBOL
Server setup file. The following information specifies the third-party software required for each feature.

• Application server support for JVM COBOL on page 15
• Database Access on page 15
• Java Development Kit (JDK) on page 15
• XML Extensions on page 15
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Application server support for JVM COBOL

Back to Top

Restriction: This topic applies only when the Enterprise Server feature is enabled.

The following application servers are supported using the following JDKs:

Application Servers JDK version Containers support version

Tomcat 7.0.39 1.6 / 1.7 Servlets 2.5

JBoss 6.1 1.6 / 1.7 Servlets 2.5

WebLogic 12.1.1 1.6 / 1.7 Servlets 2.5

WebLogic 12.1.1 on AIX 6.1 1.6.0 SR10 FP1 / 1.7 Release 1 Servlets 2.5

WebSphere 8.5 1.6 / 1.7 Servlets 2.5

WebSphere 8.5 on AIX 6.1 1.6.0 SR10 FP1 / 1.7 Release 1 Servlets 2.5

Note:

• On AIX and zLinux, you need to have IBM's JDK. The earliest supported release of IBM's JDK 1.6
is 1.6.0.13. You can get IBM's AIX JDK from IBM's Web site.

• On HP-UX, you need to have HP-UX JDK. The earliest supported release of HP-UX JDL 1.6 is
Java 6.0.13. You can get the HP-UX Java JDK from HP's Web site.

• On all other platforms, you need Oracle's JDK. The earliest supported release of Oracle's JDK 1.6
is 1.6.027. You can download Oracle's JDK from Oracle's Web site.

Database Access

Back to Top

Before you can use COBOL Server to deploy SQL applications developed with OpenESQL, DB2 ECM, or
COBSQL, ensure any third-party software prerequisites are installed and the environment is set properly.
Refer to the your product help, Welcome > Product Information > Installing... > System
Requirements... > Additional Software Requirements > Database Access, for details.

Java Development Kit (JDK)

Back to Top

Compiling
Java

Either the IBM or the Oracle Java Development Kit (JDK), version 1.5 or later, is required
for compiling Java. The JDK is downloadable from the Oracle and IBM Web sites. After
installing the JDK, you must put the tools.jar file for the JDK on your classpath, using
a command similar to:

 set classpath=jdk-install-directory\lib\tools.jar

IMTK The JDK is required for generating Java interfaces using the Deploy tool in the Interface
Mapping Toolkit or the imtkmake command.

After installing the JDK, you need to set up your Java environment.

XML Extensions

Back to Top

• XML Extensions has the same requirements as Visual COBOL. Both 32-bit and 64-bit versions are
available. See the XML Extensions for Visual COBOL, available from the Visual COBOL product
documentation section of the Micro Focus SupportLine Web site for more details.
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• Additionally, XML Extensions may be used in conjunction with Terminal Server.

Installing COBOL Server for UNIX

Downloading the Product
1. Use the download links in your Electronic Product Delivery email.

For more information follow the links for the installation instructions and the End User License
Agreement.

Installing
These are the steps to install this product:

1. Give execute permissions to the setup file:

chmod +x setup_cobol_server_2.2_update2_platform

2. Run the installer with superuser permissions:

./setup_cobol_server_2.2_update2_platform

If you don't run this as superuser, you are prompted to enter the superuser password during the install.

If you set COBDIR to an already installed product, the installer will back up the existing installation and
will install this release in the location COBDIR points to. If COBDIR is not set, the installer does a fresh
install.

The COBOL run-time is installed by default into /opt/microfocus/VisualCOBOL, (COBDIR).

To install in a different location use the -installlocation="Location" parameter to specify an
alternative directory location. For example:

./setup_cobol_server_2.2_update2_platform -installlocation="full path of 
new location"

Note: You can use variables or the tilde syntax for the path for –installlocation. For example,
the following examples are equivalent:

-installlocation="/home/myid/installdir"

-installlocation="~myid/installdir"

-installlocation="~/installdir"

-installlocation="$HOME/installdir"

You can see details about which additional parameters can be passed to the install script if you enter
the -help option.

You can use the following options to configure the Enterprise Server installation: [ -
ESsysLog="location" ] [ -ESadminID="User ID" ] [ -CASrtDir="location" ],
where:

-ESsysLog Specifies a location in which the build will create the Enterprise Server System log file -
for example, -ESsysLog="/home/esuser/logs". The default location is /var/
mfcobol/logs.

-ESadminID Sets the Enterprise Server System Administrator Process User ID from the command
line - for example, -EDadminID="esadm". The default user ID is the one that runs the
installer.
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-CASrtDir Specifies the location were the Enterprise Server run-time system files are placed - for
example, -CASrtDir="/home/esuser/casrt/es". The default location is /var/
mfcobol/es.

Note:

• The installation of this product could affect the SafeNet Sentinel licensed components running on
your machine. During installation licensing is shutdown to allow files to be updated. To ensure the
processes running on your machine are not affected, you need to use the -skipsafenet option,
which skips the installation of SafeNet:

./setup_cobol_server_2.2_update2_platform -skipsafenet

• To protect the SafeNet Sentinel installation from accidental updating you can create an empty file
named SKIP_SAFENET_INSTALL in /var/microfocuslicensing/ as follows:

touch /var/microfocuslicensing/SKIP_SAFENET_INSTALL

While the file is present, the SafeNet installer does not make changes to the installation or
shutdown the running license daemons. If licensing needs to be updated later, remove the file and
install Sentinel RMS server manually.

After Installing
When you have installed the product, you need to set the environment as described below.

1. To set up your product, execute:

. /opt/microfocus/VisualCOBOL/bin/cobsetenv

2. To verify that your product is installed, execute:

cob -V

Important: These commands set the environment only for the current shell. You need to execute
them for each new shell that you start.

To avoid having to run cobsetenv for every shell, add these commands to the shell initialization files
(such as etc/profile, etc/bashrc).

Note that cobsetenv is only compatible with POSIX-like shells, such as bash, ksh, or XPG4 sh. It is
not compatible with C-shell or pre-XPG4 Bourne shell.

Installing as an Upgrade
This release works concurrently with the previous version of COBOL Server, so you do not need to
uninstall it. There are two options for installing the latest version in this case:

• Move the existing installation to a different location and install the latest version to the default install
location specified by the COBDIR environment variable ( /opt/microfocus/VisualCOBOL, by
default).

This ensures you do not need to change your environment. To move the existing older installation to a
different location:

1. Execute the following command as root:

mv /opt/microfocus/VisualCOBOL /opt/microfocus/VisualCOBOLversion

2. Install the latest version as described in the section Installing.
• Install the latest version in a different location and set the environment to point to it. To do this, run the

COBOL Server installer with the –installlocation option:

1. Execute the following command:

. /InstallFile -installlocation="/opt/microfocus/VisualCOBOL"
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Note: You can use variables or the tilde syntax for the path for –installlocation. For
example, the following examples are equivalent:

-installlocation="/home/myid/installdir"

-installlocation="~myid/installdir"

-installlocation="~/installdir"

-installlocation="$HOME/installdir"

2. Execute cobsetenv to set the environment and point to the new install location:

. /opt/microfocus/VisualCOBOL/cobsetenv

Note that cobsetenv is only compatible with POSIX-like shells, such as bash, ksh, or XPG4 sh. It is
not compatible with C-shell or pre-XPG4 Bourne shell.

Installing silently
You can install Micro Focus products silently by using command line parameters to specify the installation
directory, user information, and which features to install. You must execute the command with superuser
permissions.

You can use the following command line arguments to install silently on UNIX/Linux:

–silent -IacceptEULA

For example, execute:

[as root] setup_filename –silent -IacceptEULA

After the application installation is complete you can install the license silently by executing the following
commands:

If you have access to the Internet
and an authorization code

Run the following as root:

cd /var/microfocuslicensing/bin
./cesadmintool.sh -authorize AuthorizationCode

If you don't have access to the
Internet but have a file from Micro
Focus that contains the license
string

Run the following as root:

cd /var/microfocuslicensing/bin
./cesadmintool.sh -install FileName

where FileName is the name of the text file that contains all the
license strings to be used.

UNIX and Linux Installer Issues

Installing on
Linux

On Linux, the 32-bit version of Java is required to install and use Visual COBOL for
Eclipse. When you start the installation, if the 64-bit version of Java is already installed
on your Linux machine, you might not be able to install Visual COBOL. This is a known
issue with the Oracle Java installers for Linux which prevent you from installing both the
32-bit and the 64-bit versions of Java on the same machine. To work around this
problem:

• Download the 32-bit Java distribution in a compressed .tar format from the Oracle
Web site.

• Untar the distribution into a location different from the one used for the 64-bit Java
version. For example, untar in /usr/local/java32 and not in /usr/local/
java.

• Set JAVA_HOME and LD_LIBRARY_PATH to the 32-bit version of Java so that it is
used to install and run Visual COBOL.
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License
Infrastructure
Installer

• On some Solaris platforms, you can receive the following error message when
SafeNet license server needs to be installed or upgraded on your machine:

tar: /safenet.tar: No such file or directory

To resolve this issue, wait for the installation to complete and then perform the
following:

1. Navigate to the safenet directory in the COBDIR location.
2. With superuser permissions execute: ./MFLicenseServerInstall.sh

• Note: The following information applies when you are installing on Red Hat
Enterprise Linux (RHEL) 7. (RHEL 7 is a beta version and support for it is a
technical preview only).

Certain configuration changes in RHEL 7 (such as the /etc/inittab file no longer
available) required a change in the MF SafeNet license installer for this platform and
the way you can manually manage the licensing service.

By default, the MF SafeNet licensing service is still configured so that it starts
automatically when starting your machine. Only on RHEL 7, you must use the
systemctl command available with the OS if you need to override the default
behaviour – for example, if you do not want run the MF SafeNet licensing service at
start-up or if you do not want the service to automatically start when you are
configuring trace levels.

1. Create a file, MFSafeNet.service, in /usr/lib/systemd/system/ with the
following contents:

----------- start of /usr/lib/systemd/system/
MFSafeNet.service -----------
    [Unit]
    Description=Micro Focus SafeNet licensing daemons. 
    Documentation=http://supportline.microfocus.com

    [Service]
    Type=forking
    ExecStart=/var/microfocuslicensing/bin/startboth.sh
    ExecStop=/var/microfocuslicensing/bin/stopboth.sh
    Restart=no

    [Install]
    WantedBy=multi-user.target
-----------  end of /usr/lib/systemd/system/
MFSafeNet.service  -----------

2. Use the systemctl command to manage the SafeNet service:

[ asroot ] systemctl option MFSafeNet

Where some of the values that option can take are:

reenable Installs the SafeNet service.

is-enabled Checks the status of the SafeNet service. Does not require root
privileges.

start Starts the SafeNet service.

stop Stops the SafeNet service.

restart Restarts the SafeNet service.

disable Disables the SafeNet service so it does not start when the
machine is booted.
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enable Enables the SafeNet Service so it starts when the machine is
booted.

For more information about systemctl, refer to the help available with the RHEL
OS.

License
Server

You need to configure the computer hostname to ensure the license server will start
properly.

To avoid performance issues, "localhost" and the computer hostname must not both be
mapped to IP address 127.0.0.1. You should only map "localhost" to IP address
127.0.0.1.

The following is an example of how to specify these entries correctly in the etc/hosts
file:

127.0.0.1 localhost.localdomain localhost
IP machinelonghostname machineshorthostname

where IP is the unique IP address of the computer in xx.xx.xx.xx format.

Repairing
If a file in the installation of the product becomes corrupt, or is missing, we recommend that you reinstall
the product.

Uninstalling
Note: Before you uninstall the product, ensure that the Enterprise Server instances and the Micro
Focus Directory Service (MFDS) are stopped.

To uninstall this product:

1. Execute as root the Uninstall_COBOLServer2.2.sh script in the $COBDIR/bin directory.

Note: The installer creates separate installations for the product and for Micro Focus License
Administration. Uninstalling the product does not automatically uninstall the Micro Focus License
Administration or the prerequisite software. To completely remove the product you must uninstall the
Micro Focus License Administration as well.

To uninstall Micro Focus License Administration:

1. Execute as root the UnInstallMFLicenseServer.sh script in the /var/
microfocuslicensing/bin directory.

The script does not remove some of the files as they contain certain system settings or licenses.

You can optionally remove the prerequisite software. For instructions, check the documentation of the
respective software vendor.

20 | Installation



Licensing Information
Note:

• If you have purchased licenses for a previous release of this product, those licenses will also
enable you to use this release.

• The latest version of the SafeNet licensing software is required. See the Software Requirements
section in this document for more details.

• Your entitlement for using this product is governed by the Micro Focus End User License
Agreement and by your product order. If you are unsure of what your license entitlement is or if you
wish to purchase additional licenses, contact your sales representative or Micro Focus
SupportLine.

To buy and activate a full unlimited license
To buy a license for Visual COBOL, contact your sales representative or Micro Focus SupportLine.

For instructions on using the Micro Focus Licensing Administration Tool, see Licensing in the Visual
COBOL help.

To start Micro Focus License Administration

From the Windows Taskbar click Start > All Programs >Micro Focus License Manager > License
Administration.

Note: On Windows 8 and Windows Server 2012, you use the Start screen to invoke programs.

Log on as root, and from a command prompt type:

/var/microfocuslicensing/bin/cesadmintool.sh

Installing licenses

If you have a license file

1. Start Micro Focus License Administration.
2. Click the Install tab.
3. Do one of the following:

• Click Browse next to the License file field and select the license file (which has an extension
of .mflic).

• Drag and drop the license file from Windows Explorer to the License file field.
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• Open the license file in a text editor, such as Notepad, then copy and paste the contents of the file
into the box below the License file field.

4. Click Install Licenses.

1. Start the Micro Focus License Administration tool and select the Manual License Installation option by
entering 4.

2. Enter the name and location of the license file.

If you have an authorization code

Authorizing your product when you have an Internet connection
Note: This topic only applies if you have an authorization code.

The following procedure describes how to authorize your product using a local or network license server.
The license server is set up automatically when you first install the product.

1. Start Micro Focus License Administration.
2. Click the Install tab.
3. Type the authorization code in the Enter authorization code field.
4. Click Authorize.

If you change the name of the machine running your license server after it has granted licenses, the
licenses stop working.

1. Start Micro Focus License Administration.
2. Select the Online Authorization option by entering 1 and pressing Enter.
3. Enter your authorization code at the Authorization Code prompt and then press Enter

Authorizing your product when you don't have an Internet connection
Note: This topic only applies if you have an authorization code.

This method of authorization is required if your machine does not have an Internet connection or if normal
(automatic) authorization fails.

1. Start Micro Focus License Administration.
2. Click Manual Authorization on the Install page.
3. Make a note of the contents of the Machine ID field. You will need this later.
4. Do one of the following:

• If your machine has an Internet connection, click the SupportLine Web link in the Manual
Authorization Information window.

• If your machine does not have an Internet connection, make a note of the Web address and type it
into a Web browser on a machine that has an Internet connection.

The Micro Focus SupportLine Manual product authorization Web page is displayed.
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5. Type the authorization code in the Authorization Code field. The authorization code is a 16-character
alphanumeric string supplied when you purchased your product.

6. Type the Machine ID in the Machine ID field.
7. Type your email address in the Email Address field.
8. Click Generate.
9. Copy the generated license string (or copy it from the email) and paste it into the box under the License

file field on the Install page.
10.Click Install Licenses.

In order to authorize your product you must have the following:

• Your authorization code (a 16-character alphanumeric string).
• The machine ID. To get this, start the Micro Focus License Administration tool and select the Get

Machine Id option by inputting 6. Make a note of the "Old machine ID".

If you have previously received the licenses and put them in a text file, skip to step 6.

1. Open the Micro Focus license activation web page http://supportline.microfocus.com/activation in a
browser.

2. Enter your authorization code and old machine ID and, optionally, your email address in the Email
Address field.

3. Click Generate.
4. Copy the licenses strings from the web page or the email you receive into a file.
5. Put the license file onto your target machine.
6. Start the Micro Focus License Administration tool and select the Manual License Installation option by

inputting 4.
7. Enter the name and location of the license file.

To obtain more licenses
If you are unsure of what your license entitlement is or if you wish to purchase additional licenses for Visual
COBOL, contact your sales representative or Micro Focus SupportLine.
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New Features in COBOL Server 2.2 Update
2

Character set enhancements
The following character sets, available using the MFCODESET environment variable, have been enhanced
or added in this release:

• Thai Extended (0066) - new
• Korean (0082)
• Simplified Chinese (0086)
• Traditional Chinese (0886)

There are also a number of double-byte character sets that are now capable of mixed single-byte and
double-byte character conversion; see the definition of MFCODESET in Environment Variables in
Alphabetical Order for more information.

Deployment to Windows XP and Windows Server 2003
Note: This feature has been added in HotFix 6 of Micro Focus Visual COBOL for Visual Studio 2012
and 2013 and COBOL Server 2012 and 2013 2.2 Update 2.

A new cbllink option, -y, is available for Visual COBOL for Visual Studio 2012 or 2013 that enables you to
create native and managed COBOL applications that you can deploy to Microsoft's Windows XP and
Windows Server 2003 platforms.

When deploying on these platforms, you must use new installers, known as Release 2 versions, for
COBOL Server 2012 and COBOL Server 2013 2.2 Update 2. Note that SOA functionality is not supported
on these platforms.

To prepare your applications for running on Windows XP or Windows Server 2003:

1. Apply HotFix 6 to your installation of Visual COBOL 2.2 Update 2 for Visual Studio 2012 or 2013.
2. Recompile your application in Visual COBOL using the cbllink -y option.
3. Install COBOL Server 2012 or 2013 2.2 Update 2 Release 2 onto the deployment machine that is

running Windows XP or Windows Server 2003.

You can download the Release 2 installers from the Product Updates section of the Micro Focus
SupportLine Web site. Refer to the readme for installation instructions.

4. Execute your application in COBOL Server 2012 or 2013 on the machine running Windows XP or
Windows Server 2003.

Language Environment (LE) Support
Language environment is a set of standard callable routines and run-time options that can be used in any
application that is written in a programming language that supports LE. It is intended to facilitate the
development of mixed-language applications. This is provided with HotFix 4 of Visual COBOL and COBOL
Server 2.2 Update 2.
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For more information, see General Reference > Language Environment (LE) Support in the Visual COBOL
product help.

External Security Facility (ESF)
The Enterprise Server External Security Facility (ESF) now supports caching the results of some security
queries. This can improve the performance of enterprise server instances and of the MFDS when they are
configured to use external security.

To enable caching, you need to set non-zero values for the Cache limit (maximum size of the cache) and
Cache TTL (Time To Live, or how long before a cached result expires) settings on the MFDS Security tab,
the Default ES Security tab, or on the Security tab for an individual enterprise server. (Currently, the
cache settings for Security Managers have no effect; you need to set cache parameters on one of the three
Security pages mentioned earlier.)

For more information, see http://supportline.microfocus.com/examplesandutilities/doxygen/caching.html.

New tunables
The following tunables have been added in this release:

reduce_java_signals This tunable specifies the options that are passed to a JVM when mixing Java and
COBOL.
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Known Issues
Refer to the Known Errors and Restrictions topic in the Product Information section of your product Help.

In addition, note the following:

Enterprise
Server

• The Historical Statistics Facility may generate incorrect records for SSTM-enabled
enterprise servers.

ICETOOL
Emulation

ICETOOL emulation for managed code is not available in this release.

Installation • Before installing this release as an upgrade to an existing installation of the previous
version 2.2 of the product, you must uninstall any HotFixes of 2.2. This is to avoid
some problems that might result in files not being installed. This is required only on
Windows.

• Before installing this release as an upgrade, ensure you create a back-up of your
Enterprise Server configuration. To do this, on the Enterprise Server Administration
home page, click Export and then select Export Enterprise Server configuration
and Security Manager definitions. This creates a backup folder in the c:
\programdata\micro focus\Enterprise Developer\MFDS. You can restore
the Enterprise Server configuration after installing this release - click Import on the
Enterprise Server Administration home page.

• On UNIX, check UNIX Installer Issues before you start the installation.

Resource
Adapters

Trying to deploy the local resource adaptor mfcobol-localtx.rar to WebLogic may
fail with a ClassCastException. To work around this issue, you need to deploy mfcobol-
xa.rar first, then need to undeploy this file and deploy the local one, mfcobol-
localtx.rar. If there are issues deploying using the WebLogic GUI, you can use the
command line. If there are issues with this as well, try reducing the length of the
command (for example, by moving the file to a location with a shorter path).
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Significant Changes in Behavior or Usage
This section describes significant changes in behavior or usage. These changes could potentially affect the
behavior of existing applications or impact the way the tools are used.

The numbers that follow each issue are the Support Incident Numbers followed by the Reported Problem
Incident (RPI) number (in parentheses).

Note: On Windows, COBOL Server 2012 and 2013 2.2 Update 2 have new Release 2 installers that
replace the GA installers. The Release 2 installers are provided with the HotFix 6 update of 2.2
Update 2 and include any fixes delivered with HotFixes 1 to 6. These release notes include
information about the issues resolved with these HotFixes on Windows that could potentially result in
a change in behavior:

• Significant Changes in Behavior or Usage in 2.2 Update 2 Release 2
• Significant Changes in Behavior or Usage in HotFix 5
• Significant Changes in Behavior or Usage in HotFix 4
• Significant Changes in Behavior or Usage in HotFix 3
• Significant Changes in Behavior or Usage in HotFix 2
• Significant Changes in Behavior or Usage in HotFix 1
• Significant Changes in Behavior or Usage in 2.2 Update 2 GA

Significant Changes in Behavior or Usage in 2.2 Update 2 Release 2

Back to Top

The numbers that follow each issue are the Support Incident Numbers followed by the Reported Problem
Incident (RPI) number (in parentheses).

• CAS Security

CAS Security

Back to the list

• The Enterprise Server External Security Facility now includes MLDAP ESM Module 2.0, with a new
algorithm for identifying the best-matching resource-access rule and ACE for resource-access security
checks. This algorithm is faster and matches most customers' expectations.

The new algorithm also provides an optional "username substitution" feature. It can be enabled by
setting "rule substitutions" to "yes" in the [Operation] section in the Security Manager configuration
text area. When this is enabled, the string "${user}" in a resource-rule name will be replaced with the
name of the user that makes the request. For example, a DATASET rule named "USERS.${user}.**"
would apply to datasets with the requesting user's name as the second qualifier. In rare cases,
customers with complex, ambiguous resource-access security rules might see experience changes in
behavior as a result of the new algorithm. The old algorithm is still supported and can be enabled by
setting "version 1 authentication" to "yes" in the [Operation] section of the Security Manager
configuration.

2807531 (1097783)

Significant Changes in Behavior or Usage in HotFix 5

Back to Top

This HotFix does not include any changes that could affect the behavior of existing applications.
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Significant Changes in Behavior or Usage in HotFix 4

Back to Top

The numbers that follow each issue are the Support Incident Numbers followed by the Reported Problem
Incident (RPI) number (in parentheses).

Host Compatibility Option for SQL Server (HCOSS)

The mainframe dialect DB2 CHAR() function now calls a new SQL Server scalar function dbo.MFCHAR().
To create the new function in your application’s SQL Server database, you can either:

• Run a DSN bind against the customer database.

Or:
• Execute the %ALLUSERSPROFILE%\Micro Focus\Enterprise Developer\hcoss

\InstallDigitsFunction.sql script.

Additionally:
• The return type for the HCOSS DB2 CHAR() function has changed from CHAR(255) to

VARCHAR(255).

2804069 (1097253)

Significant Changes in Behavior or Usage in HotFix 3

Back to Top

This HotFix does not include any fixes that result in changes in behavior or usage.

Significant Changes in Behavior or Usage in HotFix 2

Back to Top

This HotFix does not include any fixes that result in changes in behavior or usage.

Significant Changes in Behavior or Usage in HotFix 1

Back to Top

The numbers that follow each issue are the Support Incident Numbers followed by the Reported Problem
Incident (RPI) number (in parentheses).

• File Handling - External File Handler
• J2EE Connector

File Handling - External File Handler

Back to Top

• Custom file handlers (using DYNREDIR) are now called for each part of a concatenated file.

2795077 (1096322)

J2EE Connector

Back to Top

• This release provides a new command-line argument to Java, mf.ssl.algorithm, which can be set to an
appropriate algorithm.

2799213 (1096684)
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Significant Changes in Behavior or Usage in the 2.2 Update 2 GA

Back to Top

• Compiler
• Compiler Front-end
• Documentation
• J2EE Connector

Compiler

Back to the list

• When using the HOSTRW directive with the mainframe dialect, Report Writer will now produce the full
range of ASA control characters and will emulate mainframe print files.

2697615 (1094527)

Compiler Front-end

Back to the list

• Fixed Binary (p<=7) is now an 8-bit, signed, 2's complement binary integer by default.

Documentation

Back to the list

• The default setting for the MFALLOC_PCFILE environment variable has changed; the default is now set
to Y, which means that when cataloguing a file that has a DCB attribute of DSORG=PS, a physical file is
created for it if one does not exist. Previously, the default was set to N, which meant that a file was not
created.

2697571 (1094370)

J2EE Connector

Back to the list

• The listSystem.properties file in package com.ibm.ctg.client was missing documentation for some
sections.

(606556)
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Resolved Issues
The numbers that follow each issue are the Support Incident Numbers followed by the Reported Problem
Incident (RPI) number (in parentheses).

Note: On Windows, COBOL Server 2012 and 2013 2.2 Update 2 have new Release 2 installers that
replace the GA installers. The Release 2 installers are provided with the HotFix 6 update of 2.2
Update 2 and include any fixes delivered with HotFixes 1 to 6. These release notes include
information about the issues resolved with these HotFixes on Windows:

• Resolved Issues in 2.2 Update 2 Release 2
• Resolved Issues in HotFix 5
• Resolved Issues in HotFix 4
• Resolved Issues in HotFix 3
• Resolved Issues in HotFix 2
• Resolved Issues in HotFix 1
• Resolved Issues in 2.2 Update 2 GA

Resolved Issues in 2.2 Update 2 Release 2

Back to Top

The numbers that follow each issue are the Support Incident Numbers followed by the Reported Problem
Incident (RPI) number (in parentheses).

• .NET Compiler
• CAS Security
• MF Directory Server
• SQL: DB2 ECM
• SQL: OpenESQL

.NET Compiler

Back to the list

• For class programs containing COBOL files declared in the OBJECT section, it is now possible to
explicitly add the program to a run unit. Previously, this would cause a run-time exception.

2819597 (1099273)
• The use of the SCREEN SECTION CONTROL phrase in .NET unverifiable code no longer causes the

generation of illegal code.

2818736 (1099170)
• For class programs containing COBOL files declared in the OBJECT section, it is now possible to

explicitly add the program to a run unit. Previously, this would cause a run-time exception.

2802641 (1099053)

CAS Security

Back to the list

• Audit SNMP:Cannot find module (NET-SNMP-PASS-MIB).

2817175 (1098946 )
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MF Directory Server

Back to the list

• The Enterprise Server Administration web page makes additional authorization checks before
displaying screens.

2819069 (1099192)
• The Enterprise Server Administration web page no longer displays sensitive session data.

2818974 (1099178)
• Password length restriction has been fixed in the Enterprise Server Administration login page.

2818973 (1099179)

SQL: DB2 ECM

Back to the list

• The DB2 ECM incorrectly generated code to process SET CURRENT PACKAGE PATH, resulting in
SQLCODE -4952 when executed.

2817342 (1098963)

SQL: OpenESQL

Back to the list

• Windows GUI projects compiled with the SQL compiler directive might throw a
MicroFocus.COBOL.Program.COBOLStopRunException on GOBACK.

2816463 (1098907)

Resolved Issues in HotFix 5

Back to Top

The numbers that follow each issue are the Support Incident Numbers followed by the Reported Problem
Incident (RPI) number (in parentheses).

• .NET Compiler
• CAS (COBOL App Server) General
• CAS Security
• Compiler
• LE370 Support
• MF Communications Server
• MF Server Administrator (GUI)
• Setup

.NET Compiler

Back to the list

• Verification or run time errors are no longer produced when NUMPROC(ACOS) is specified, and a level
88 item is declared for a numeric item in the Linkage section of your program.

2815137 (1098693)

CAS (COBOL App Server) General

Back to the list

Resolved Issues | 31



• You can now use the environment variable ES_ESM_DISABLE_DFLTUSER_ESMAC in order to disable
the ESMAC default user. When this variable is set, the "DEFAULT" button on the logon screen is
disabled and a valid userid and password must always be entered.

2813092 (1098438)
• DBCS fields are now processed correctly when the PS attribute is set in the DSECT rather that defined

in the MAP in single field, groups and OCCURs.

2811683 (1098233)

CAS Security

Back to the list

• This release enables you to prevent an Enterprise Server Monitor and Control (ESMAC) user from
displaying an enterprise server's environment variable settings using the "Env. Vars." button or the direct
URL. To enable this feature, you need to create a new element (ENV*) in the LDAP schema in the
CN=MFESMAC group below CN=Enterprise Server Resources. This release includes an updated copy
of the supplied LDIF import files that contain this change. Once this element is installed in the security
manager, you can control the visibility of the environment variables page by configuring the group/user
access rights using the microfocus-MFDS-Resource-ACE attribute.

2811696 (1098264)

Compiler

Back to the list

• Data names that start with a numeric digit and contain DBCS characters are now accepted by the
Compiler.

2813223 (1098456)
• A MOVE operation of an alphanumeric literal to an unsigned numeric DISPLAY field under RM/COBOL

emulation now executes correctly.

2812561 (1098446)

LE370 Support

Back to the list

• The Language Environment functions CEEGMT, CEEUTC and CEELOCT now return the number of
seconds to millisecond precision.

2796098 (1098276)

MF Communications Server

Back to the list

• An issue with leaked sessions for IMS Connect conversations has been corrected.

2797552 (1096486)

MF Server Administrator (GUI)

Back to the list

• If access to Enterprise Server Administration is restricted by use of an MLDAP ESM-based external
Security Manager, you can now configure a user to have access to the "Security" menu item but not to
the "Options" menu item.

2804728 (1097916)
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Setup

Back to the list

• Micro Focus COBOL Server 2012 and COBOL Server 2013 now support Microsoft Windows XP and
Windows Server 2003 platforms.

2804421 (1097492)

Resolved Issues in HotFix 4

Back to Top

The numbers that follow each issue are the Support Incident Numbers followed by the Reported Problem
Incident (RPI) number (in parentheses).

• Compiler
• File Handling - External File Handler
• LE370 Support
• MF Directory Server
• MF Server Administrator (GUI)
• MLDAP API Interface
• XML syntax support runtime

Compiler

Back to the list

• The Compiler no longer errors preprocessed lines containing non-ASCII characters in the indicator
area. Previously, this could cause user programs using the htmlpp preprocessor to fail to compile.

2805067 (1097977)
• The specification of an alphanumeric literal in the VALUE clause of a DBCS data item (i.e. the G\N

prefix is missing) is now accepted as an MF extension. This still generates an error under mainframe
dialects, but can be hidden/suppressed like any other flag message.

2798426 (1096574)

File Handling - External File Handler

Back to the list

• MFSORT now takes the record length from a previous output file, if its record length is specified, rather
than defaulting to the value in the SORTIN statement.

2808188 (1098243)

LE370 Support

Back to the list

• Mainframe Language Environment support (LE Services) is now available in Micro Focus Visual
COBOL and COBOL Server.

2799388 (1097806)

MF Directory Server

Back to the list

• It is now possible to expand and collapse items within the tree view of the external security manager
security resources in Enterprise Server Administration.

2801421 (1096979)
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MF Server Administrator (GUI)

Back to the list

• Previously, when expanding or collapsing items in the tree view for external Security Manager within
Enterprise Server Administration, items associated with a user or a group no longer would always move
to the top of the resource list.

2803399 (1097848)

MLDAP API Interface

Back to the list

• The MLDAP ESM module now recognizes a wider range of errors that indicate that the specified LDAP
server is unavailable and, if configured, the server will retry to establish a connection.

2799921 (1098128)

XML syntax support runtime

Back to the list

• The namespace prefix in the namespace declaration is now handled correctly when the element itself
does not contain a prefix.

2799691 (1098150)

Resolved Issues in HotFix 3

Back to Top

The numbers that follow each issue are the Support Incident Numbers followed by the Reported Problem
Incident (RPI) number (in parentheses).

• .NET Compiler
• CAS (COBOL App Server) Security
• Compiler
• File Handling - Fileshare
• NCG
• Run-Time System

.NET Compiler

Back to the list

• The INITIALIZE statement is now working as expected when applied to a group item where an
OCCURS subgroup follows a FILLER data item. Previously, this could produce bad code, initializing
incorrect areas of the group.

2805149 (1097372)

CAS (COBOL App Server) Security

Back to the list

• The number of security manager user group members displayed by the Enterprise Server
Administration and the esfadmin tool is no longer limited to a maximum of 1024.

2807579 (1097703)
• Trying to use the SNMP audit emitter with Enterprise Server no longer fails with a run-time system error

114.

2800729 (1096951)
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Compiler

Back to the list

• Compiling a program with the COBSQL preprocessor, which contains a COPY REPLACING statement
with trailing spaces in the replacement pseudo text, now works as expected.

2807470 (1097737)
• When importing a Visual COBOL source file, the generation of a CBLast (COBOL Abstract Symbol

Table) file no longer hangs when instructed to process a COBOL.DIR file.

(609062)

File Handling - Fileshare

Back to the list

• When a file is closed under Enterprise Server, the file's details are correctly removed from Fileshare.
Previously, some details were not removed.

2810549 (1098111)

NCG

Back to the list

• An error has been fixed in COMPUTE statements of the following form: COMPUTE a = b / constant
where a and b are COMP-3 or DISPLAY; a has greater than 19 digits and b has less than or equal to 19
digits, and constant is a literal which is a power of 10 (such as 10, 100, 1000, etc.)

2808008 (1097715)

Run-Time System

Back to the list

• On a 32-bit Enterprise Server running on Windows, tasks that are blocked in the operating system can
now be canceled without terminating the SEP process.

2807997 (1097918)

Resolved Issues in HotFix 2

Back to Top

The numbers that follow each issue are the Support Incident Numbers followed by the Reported Problem
Incident (RPI) number (in parentheses).

• CAS (COBOL App Server) General
• Compiler
• Documentation
• File Handling - External File Handler
• File Handling - Fileshare
• MLDAP API Interface
• Run-Time System

CAS (COBOL App Server) General

Back to the list

• An issue with dynamic debugging has been fixed where, previously, the ports that were freed were not
being reallocated.

2785911 (1095510)

Resolved Issues | 35



Compiler

Back to the list

• Compilation with a mainframe dialect, of a program containing a CALL statement with a mixture of
non-01 level group items and literals, now proceeds as expected with no internal error produced.

2803613 (1097190)

Documentation

Back to the list

• The product documentation about the START statement and Relation Conditions now states that THEN
may be used instead of THAN.

2799291 (1096903)
• The Enterprise Server documentation for Retain Periods has been updated to include additional

information specific to spool output.

2790146 (1095777)

File Handling - External File Handler

Back to the list

• The rollback recovery process is now working as expected.

2802180 (1097066)

File Handling - Fileshare

Back to the list

• When handling indexed files, the correct .IDX file is now being processed.

2803247 (1097279)

MLDAP API Interface

Back to the list

• The MFDS GUI and the ESFADMIN utility now display the pages with LDAP query results.

2681539 (1092705)

Run-Time System

Back to the list

• The tunables default_cancel_mode and subsystem_cancel_mode both have a new setting, which
enables programs to remain in memory after they are canceled; this is opposed to the default behavior,
which physically removes .dll files and shared objects from memory when they are canceled.

2690881 (1096628)

Resolved Issues in HotFix 1

Back to Top

The numbers that follow each issue are the Support Incident Numbers followed by the Reported Problem
Incident (RPI) number (in parentheses).

• CAS (COBOL App Server) General
• Compiler
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• Compiler - Managed Code
• File Handling - External File Handler
• MF Directory Server
• Run-Time System
• XML Syntax Support Run-Time

CAS (COBOL App Server) General

Back to the list

• The characteristics of an FCT that references a cataloged file are now refreshed on each file open.

(606250)

Compiler

Back to the list

• A source line longer than the maximum supported by the compiler no longer receives an error about
truncation if the line is simply a comment.

(607851)

Compiler - Managed Code

Back to the list

• When compiling for managed code (.NET or JVM), a zero length literal used as a value for a PIC N data
item no longer crashes compilation with run-time error 181.

2799176 (1096677)
• Comparisons between PIC N or PIC G items and ALL hex-literals are now working correctly.

2795393 (1096266)

File Handling - External File Handler

Back to the list

• The ACUFH interface between the MF File Handler and the RM File Manager will no longer report an
05 status (optional file created) to more than one COBOL run unit for creation of the same file. The 05
status will be reported to the COBOL run unit that actually created the file. The RM File Manager that
runs under ACUFH and the Micro Focus File Handler for Visual COBOL now includes optimizations that
enable it to use pread and pwrite system calls and to report status 99 (record locked) quicker. These
optimizations match the optimizations added to the RM File Manager within RM/COBOL.

(607495)

MF Directory Server

Back to the list

• The MFDS GUI now correctly displays external Security Manager resource ACL strings that are greater
than 3K byte length.

2800727 (1096978)
• The MFDS -x XML export option was not exporting Windows Monitoring and Management configuration

values for enterprise server instances.

2794382 (1096428)
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Run-Time System

Back to the list

• An error in generated code when initializing comp-2 data items from fractional literal values has been
fixed.

2800938 (1096960)

XML Syntax Support Run-Time

Back to the list

• The XML I/O run-time used to read the whole document into memory which caused an out-of-memory
error.

2801337 (1096999)

Issues Resolved in 2.2 Update 2 GA

Back to Top

• .NET Compiler
• .NET ESQL Support
• .NET Run-Time System
• Adis
• CAS (COBOL App Server) General
• CAS Admin Console
• CAS Security
• CAS XA Switch modules
• CCI TCP/IP
• Compiler
• Codeset Support
• Documentation
• ES Cluster
• File Handling: External File Handler
• JVM: Compiler
• JVM: Run-Time System
• MF Communications Server
• MF Directory Server
• MFA Server
• MFA SyncMon
• MFBSI
• MFIO
• NCG
• OO Run-Time System (32-bit)
• Run-Time System
• Setup Issues
• SQL: Cobsql
• SQL: DB2 ECM
• SQL: OpenESQL
• Unassigned
• Web Service Client
• XML syntax support runtime
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.NET Compiler

Back to the list

• Comparisons between PIC N or PIC G items and ALL hex-literals are now working correctly.

2795393 (1096266)
• The CURRENT-DATE function, using reference modification with an implied length (e.g. FUNCTION

CURRENT-DATE(3:)), now behaves as expected when compiled to managed COBOL.

2788009 (1095691)
• In Managed COBOL only, an unreferenced elementary field of an "IS EXTERNAL" data item would not

be initialized by the INITIALIZE verb, even though the containing group item was referenced. This is
now working correctly.

2787385 (1095405)
• The performance of the .NET Compiler has been enhanced. Previously, programs that included multiple

pointers and comp-5 items with value clauses could take a long time to load. The use of the XML
preprocessor could lead to this condition, since it generates data of this type.

2784731 (1095278)
• Correct behavior is now being displayed when the INITIALIZE statement is used on DBCS data, where

the initializing literal is a single-byte alphanumeric.

2784714 (1095079)
• Exponentiation with a literal exponent of 2 (or multiple of 2) on a signed field is now working as

expected. In previous versions of the product, such an operation could lead to invalid code.

2784503 (1095063)
• Compatibility of SPZERO with native COBOL code has been improved in the following two cases: 1) If

a-9 = space (where a-9 is defined as pic 9(n) DISPLAY) With SPZERO on, this comparison will now
always yield a false result. 2) Move a-x to a-9 (where a-x is pic x(n) and a-9 is pic 9(n)) In the case
where a-x contains spaces, this move will now result in a-9 containing zeroes.

2676477 (1093768)

.NET ESQL Support

Back to the list

• When using OpenESQL for ADO.NET, the first execution of a statement for SQL Server no longer locks
the varbinary host variable sizes.

2791617 (1095920)
• The OpenESQL pre-compiler sometimes generated incorrect code if a PIC X(n) VARYING host variable

was used in a COBOL JVM project.

2787380 (1095934)
• The managed SQL run-time system now correctly handles variable string lengths for both 49-level

COMP fields and 49-level COMP-5 fields.

2782088 (1094793)
• The OpenESQL native ODBC wrapper used in managed applications would sometimes incorrectly set

index past the end of table before moving information to the table which resulted in a COBOL subscript
error.

2780447 (1094665)

.NET Run-Time System

Back to the list

• In managed code, multiple processes using the same input file in a SORT statement will no longer get
intermittent open failures.
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2790155 (1095759)

Adis

Back to the list

• When using X"AF" function 81, screen attributes are now inherited correctly.

2782580 (1094878)
• Using an ACCEPT statement followed by a display of an OUTPUT RIGHT item and an ERASE EOL

item no longer causes a corruption of a screen section.

2695444 (1093924)

CAS (COBOL App Server) General

Back to the list

• Using the INPUTMSG parameter for the XCTL and LINK commands is now working correctly.

2790518 (1095805)
• On user syncpoint, a 500-error no longer returns to the client if the application did not issue a WEB

SEND.

2780958 (1094671)
• When linking to a program with a channel, the current channel was not always honoured.

2779977 (1094556)
• Enterprise Server is not longer sending a FREEKB to the terminal at the end of a task when there is

more work pending for the terminal.

2691707 (1093544)
• You no longer receive an intermittent signal 11 in MFCS during shutdown.

CAS Admin Console

Back to the list

• When starting an enterprise server instance, the location of the work files may differ depending on
whether the instance was started using a browser or from the command line. See the documentation for
"system directory" in the topic "Server Instance Properties General".

2660616 (1090612)

CAS Security

Back to the list

• The es-ldap-update.cmd script has been updated for the Visual COBOL product line. The script is used
to install a sample set of security definitions when LDAP-based security is used with Enterprise Server.

CAS XA Switch modules

Back to the list

• EXEC SQL RESET CONNECTION has been updated and is used to drop Global Temporary Tables at
the end of tasks.

2693269 (1093613)
• EXEC SQL SYNCPOINT has been updated and now correctly handles ON COMMIT actions for

DECLAREd global temporary tables.

2682648 (1093611)
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CCI TCP/IP

Back to the list

• CCITCP client connections could intermittently fail on some platforms due to transient errors in the
TCP/IP stack. CCITCP is now more aggressive at detecting and retrying client connections under these
conditions. This primarily affects COBOL Web services clients, some Enterprise Server command-line
utilities, and Fileshare clients.

2794263 (1096355)
• INT and CSO modules that use the Casfile API can now successfully connect to SSL-secured

Enterprise Server listeners.

2696022 (1094318)

Compiler

Back to the list

• Programs with a mainframe dialect that contain a paragraph declaration that is not preceded by a period
and that is previously referenced now compile as expected.

2793046 (1096112)
• Complex table VALUE syntax is now working as expected.

2792013 (1095954)
• Compilation no longer hangs when REPLACE and COPY REPLACING is active and the source code

has multiple lines ending in a comma.

2791425 (1095905)
• READ and WRITE statements with the RM filehandler for files defined with the "RECORD VARYING

FROM 0 TO ..." syntax now behave as expected.

2785986 (1095385)
• An INSPECT CONVERTING statement on a subscripted sliding item now executes as expected.

2785328 (1095244)
• Setting the LINE-COUNT(2) Compiler directive on a project no longer causes the IDE to crash during a

background syntax check.

2784751 (1095114)
• Data items with DBCS characters which are defined as SQL data types are now processed correctly.

2783799 (1094976)
• The OSEXT and COPYEXT directives now work with quoted names (with or without spaces).

2780350 (604653)
• Compiling programs that use both the "WITH DEBUGGING MODE" and "IS INITIAL" clauses now

produces correct object code.

2779266 (1094498)
• Programs that use an external report file now execute as expected.

2698699 (1094352)
• The performance of the syntax constructs "SET ADDRESS OF .. TO ADDRESS OF ..." when using the

AMODE compiler directive has been improved.

2697051 (1094174)
• A MOVE of 'ALL <alphanumeric literal>' to a numeric display item is now correctly emulated under

DIALECT(RM).

2648551 (1089534)
• The IDE now correctly indicates the location of errors in multi-program source.

2541308 (1081744)
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• Using Watch/Quick Watch on a data item with subscripts, where one of the subscripts is also
subscripted, now produces the correct results.

2463792 (1075281)
• A program that exceeds the system limit of 254 DETAIL groups for a report now receives an appropriate

error message "COBCH1692S Too many DETAIL groups specified for report".

2458349 (1096071)

Codeset Support

Back to the list

• The offset of input segments is now calculated correctly. In order to apply the fix, you must regenerate
the MFS source.

2695463 (1093948)

Documentation

Back to the list

• The documentation for the MFBSI CTF trace option has been corrected in the online help. It now reads:
mftrace.comp.mfbsi.emx#all = true

2693323 (1093631)
• The description for the MULTI-NESTED topic under DB2 Compiler Directive Options was incorrect.

2783274 (1094953)
• The topic about the ILSMARTLINKAGE Compiler directive in the product help now includes information

about the get_Reference() method (JVM COBOL) and the .Reference property (.NET COBOL) that the
classes and types generated with ILSMARTLINKAGE produce. If you pass such a class or type as a
parameter to a program that receives it "by reference”, you need to use the "by reference" object by
specifying the get_Reference() method or .Reference property, respectively. This returns an object that
encapsulates the ILSMARTLINKAGE parameter so it be used with a method that is declared as "by
reference". You also need to use get_Reference() or .Reference with the RunUnit:Call() method.

2779516 (1094514)
• The setup file installs the product and any missing third party software, and will install the Java 7

Update 27. This information is now included in the Software Requirements section of the product help.

2785427 (1095199)
• The setup file installs the product and any missing third party software, and will install the .NET

Framework v4.0. This information is now included in the Software Requirements section of the product
help.

2672774 (1095057)

Enterprise Analyzer Integration

Back to the list

• An issue with the DISPLAY ... LINE statement being unable to process expressions has been fixed.

ES Cluster

Back to the list

• In a clustered configuration of Enterprise Server, on some platforms, MFCS could crash during startup
of an enterprise server instance due to attempting to process communications with the cluster manager
before initialization was complete.
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File Handling - External File Handler

Back to the list

• An automatic close of a file opened in a container no longer causes a rollback.

2790362 (1095956)
• Previously, a file could be left with its integrity bit set to transactional if a process included a mix of

transactional and non-transactional opens and the last close of the file was a non-transactional one.

2785682 (1095657)
• The transaction log now correctly shows the timestamp for the prepare, commit and rollback operations.

2784948 (1095162)
• If a VSAM file is opened for an OUTPUT in a RANDOM/DYNAMIC access mode, the file virgin state is

changed to a non-virgin even if no records are written to it. If the file is opened for an OUTPUT in a
SEQUENTIAL access mode, its virgin state is retained.

2781975 (1094779)
• The MFALLOC_PCFILE environment variable now works as expected. Previously, it would be bypassed

when the ES_ALLOC_OVERRIDE environment variable was also specified.

2692290 (1093977)
• During Open OUTPUT of a VSE VSAM reusable file, with DISP=OLD, the file is no longer reset; the file

is opened in EXTEND mode.

2638640 (1089073)

JVM - Compiler

Back to the list

• The INSPECT CONVERTING statement, when applied to DBCS data, now produces the expected
results when compiling to JVM COBOL.

2784715 (1095080)
• A STRING statement that has contiguous literal operands with a total length of more than 8192 bytes no

longer causes system errors during compilation.

2700765 (1094513)
• When compiling JVM COBOL, moving subscripted operands to multiple targets now works as expected.

2695442 (1093923)
• Previously, with JVMGEN on, the Compiler was failing to compile a program that includes a working-

storage section with a very large number of VALUE clauses. Although this may still happen in some
cases, the incidence of problem programs has been greatly reduced.

2693676 (1094165)

JVM - Run-Time System

Back to the list

• Previously, when compiling an application with the JVMGEN Compiler directive and the application
included a large number of "value" clauses in the working-storage section, the "value" clauses were not
always.

2784025 (1095274)
• Negative single digit results no longer evaluate to zero.

2696486 (1094062)
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MF Communications Server

Back to the list

• Certain Enterprise Server administration actions such as notifying a running enterprise server of a
security update could cause MFCS to hang.

2784219 (1095045)

MF Directory Server

Back to the list

• The Enterprise Server Administration no longer terminates when trying to display a list of users
registered on an external Security Manager.

2788461 (1095505)
• The 64-bit MFDS is now able to read and write XML configuration data.

MFA Server

Back to the list

• This release provides a fix for abend 0C4 in XDBWWWM0.

MFA SyncMon

Back to the list

• Previously, PDS members without ISPF statistics caused an error message "Input string was not in a
correct format" when processing the timestamp. Now the current time is used. SyncMon2 also
downloads the entire PDS every time.

2783738 (1094996)
• The product now displays a useful error message and not an exception when a user specifies an illegal

output.
• Removing a rule from the SM2 dialog no longer causes other rules to be removed from the dialog.

MFBSI

Back to the list

• Support has been added for the Control-M $JULIAN/$GREG/$WEEK# functions using the Control-M
expression or variable parameters.

2698531 (1094301)

MFIO

Back to the list

• Specifying a leading ";" in an environment variable containing a file path no longer results in the file not
being found.

2693286 (1093707)

NCG

Back to the list

• Using a "MOVE alphanumeric-item to numeric-item" statement in programs generated with the
CHECKNUM directive now correctly results in a Run-Time System error 163 (invalid numeric data)
message.

2796191 (1096340)
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• Building programs that use DIALECT(RM) and that contain calls with more than eight parameters no
longer fails with a RTS 114 error.

2788746 (1095583)
• An issue with statements of type "compute edited-item = expression", where expression evaluates to a

value larger than the value that edited-item can store, and so truncation is required, has been fixed. This
only affected Intel x86 32-bit generated code when the HOSTARITHMETIC Compiler directive was set.

2782400 (1094841)
• Compiling code that contains alphanumeric intrinsic functions with very long parameters could

previously result in an error at generate time. It now generates successfully.

2782306 (1094942)
• A bug in the MOVE statement where the source item is S9(15)V99 COMP-3 and the target item

S9(8)V9(9) comp-3 has been fixed.

2697129 (1094607)
• The performance of arithmetic with COMP-3 items on the 390 platform has been greatly improved.

2683340 (1092877)
• Programs that include 8-byte comp/comp-5 variables in a PERFORM loop termination condition, with

the OPT Compiler directive specified, now compiles successfully in 32-bit mode.
• An issue with the code generated for alphanumeric moves on Intel x86-32 when the OPT(4) Compiler

directive was specified has been fixed.
• You no longer receive an RTS 114 error when processing invalid directives.
• You no longer receive an RTS 200 error in debuggable generated code (.gnt) programs compiled with

the amode(31) Compiler directive.
• A problem with setting breakpoints on some EXEC SQL statements has been fixed.

OO Run-Time System (32-bit)

Back to the list

• Native object-oriented programs with multiple methods that use local-storage data now execute as
expected.

Run-Time System

Back to the list

• You can now use a configuration file that has a spacey filename to start Audit Manager as a service.

2785459 (1095200)
• The debugger now displays correctly the content of non-ASCII characters in programs compiled with the

CHARSET(EBCDIC) Compiler directive.

2782246 (1094947)
• In some situations, the processing of a Run-Time System error in an Enterprise Server container could

cause the container to hang or crash. This has been fixed.

2690883 (1094783)

Setup Issues

Back to the list

• The mfsupport permissions have been modified so that any user with access to the product can now
run mfsupport.

2781319 (1094713)
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SQL: Cobsql

Back to the list

• COBSQL now correctly processes source lines that only contain a single character at column 72.

2781493 (1094727)
• COBSQL now correctly processes SQL statements with continuation lines.

2781299 (1094716)

SQL: DB2 ECM

Back to the list

• A new directive option, DB2(ALEBRA), has been added to the DB2 ECM preprocessor to prevent
ASCII/EBCDIC translation of host variables used in SQL statements. DB2(ALEBRA) is applicable only
when using the EBCDIC character set and the Alebra Remote DB2 Access software.

2789897 (1095736)
• Programs using SQL TYPE AS CLOB compiled with host variables were flagged with COBCH0233S

Compiler error because the reserved word "AS" is not supported in mainframe dialects such as
Enterprise COBOL. The DB2 pre-compiler now resolves this by adding "AS" as a valid reserved word.

2698988 (1094584)
• While editing the source code in the IDE during syntax checking, the DB2 pre-compiler sometimes

generated incorrect error messages for DECLARE CURSOR statements if they were defined in the
WORKING-STORAGE section when the DB2 BACKGROUND PARSING option was set to NONE.

2698133 (1094267)
• COMP-3 host variables prevented the porting of JVM COBOL object code between machines with

different byte ordering architectures.

2695871 (1094325)

SQL: OpenESQL

Back to the list

• The OpenESQL preprocessor incorrectly terminated a host variable lookup resulting in a COBES0109
error.

2795391 (1096265)
• Using a SQL Server fast forward cursor with an ODBC driver that does not support MARS caused a

rollback when the cursor was closed.

2793798 (1096126)
• Applications migrated from earlier products that used the tokens ON and ROW_NUMBER as column

names in SQL statements were compiling with errors.

2793301 (1096088)
• The OpenESQL preprocessor produced a compilation error for EXEC SQL select ... INTO

<TableName> ... END-EXEC.

2792715 (1096102)
• The OpenESQL runtime for ADO.NET was incorrectly returning the native database error in

SQLERRD(1).

2790152 (1095758)
• A problem fetching decimal columns using OpenESQL for ODBC in locales where the decimal point is

not '.' has been fixed. In addition, to optimize performance for the majority of ODBC applications, the
default setting for SQL(DECDEL) has been changed from NODECDEL to DECDEL=LOCAL. Use an
explicit SQL(NODECDEL) directive for Windows applications that change the effective locale
dynamically at runtime.
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2788986 (1095766)
• The insertion of values larger than 8000 characters from a PIC X host variable into a SQL Server

VARCHAR(MAX) column caused an error.

2787574 (1095428)
• Some valid ODBC SQL expressions caused the OpenESQL preprocessor to issue errors when it

encountered a 'BY' token.

2787068 (1095429)
• Valid SQL "PARTITION BY" clauses caused compiler errors when using OpenESQL.

2786991 (1095386)
• Performance of the OpenESQL runtime system for ODBC required improvement when fetching

character data.

2785410 (1095165)
• The OpenESQL preprocessor generated invalid code resulting in undefined ECM error code 302 when

an array host variable was mixed with regular host variables in a parameter list in the EXEC SQL CALL
statement.

2785284 (1095354)
• A memory leak occasionally occurred when multiple prepares of the same dynamic SQL statement

existed in the OpenESQL JDBC runtime system.

2784039 (1095123)
• The OpenESQL preprocessor incorrectly interpreted the SQL CONCAT character as DBCS when using

SQL(CONCAT=124) for the CONCAT character, resulting in compilation error.

2783615 (1094981)
• When compiling for ODBC, the OpenESQL preprocessor now generates an error message,

COBES0123, when it encounters an EXEC SQL statement that contains a host or indicator variable that
uses a subscript. Subscripts of this type are not supported in ODBC.

2781022 (1094686)
• The GEN-HV-FROM-GROUP SQL compiler directive option intermittently caused truncation of SQL

VARCHAR data type occurrences.

2780748 (1094649)
• SQL(CHECK) caused compilation errors when compiling source programs containing DBCS characters

in column names. Programs containing DBCS characters in column names that were compiled using
SQL(NOCHECK) caused runtime errors.

2780185 (1094588)
• The GEN-HV-FROM-GROUP compiler directive option has been added to the OpenESQL preprocessor

to support the selection of multiple levels in a group item. Specify SQL(GEN-HV-FROM-GROUP) when
compiling to generate host variables for each elementary definition in a group record.

2699622 (1094395)
• OpenESQL for JDBC did not correctly open insensitive cursors.

2699442 (1094415)
• OpenESQL Assistant was inconsistently inserting the query function in the "B" area for queries and

column 8 for other code.

2697908 (1094190)
• The OpenESQL preprocessor sometimes incorrectly defined host variables when an indicator variable

array was used with an SQL statement.

2696332 (1094052)
• You no longer receive errors when parsing Oracle INTERVAL expressions.

2694071 (1094337)
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• A problem that prevented a COBOL stored procedure from being called from a nested trigger has been
fixed.

2690749 (1094042)
• The restriction that program names in an application must be unique in the first 24 characters in order

for OpenESQL to handle cursors correctly has been increased to 30 characters. This is to restore
backwards compatibility with earlier Micro Focus products.

2685901 (1093808)
• HCOSS now provides better control for ODBC applications that use data that: o Uses the DATE and

TIME formats specified by SQL(DATE) and SQL(TIME) o Is stored as character data in the database
You can now do any of the following: o Specify host variable types to use with DETECTDATE. o Set the
ODBC runtime to determine parameter data types by querying the server (this option uses additional
runtime overhead). o Tag string literals in SQL statements with special SQL comments that specify the
type of literal. With this option, literals tagged with /*#CHAR*/ are not reformatted when
SQL(DIALECT=MAINFRAME) is set.

2685625 (1093540)

Unassigned

Back to the list

• A channel created by a program invoked by a CALL statement is now visible to the programs running at
the same level.

2698335 (1094225)

Web Service Client

Back to the list

• Namespaces not declared on the schema root, i.e. declared either with an element declaration or on the
WSDL root, will now be processed properly and no longer ignored.

2583853 (1085102)

XML syntax support runtime

Back to the list

• The HTMLPP preprocessor now handles copybooks with filenames longer than eight characters
correctly.

2783315 (1095092)
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Updates and SupportLine
Our Web site gives up-to-date details of contact numbers and addresses.

Further Information and Product Support
Additional technical information or advice is available from several sources.

The product support pages contain a considerable amount of additional information, such as:

• The WebSync service, where you can download fixes and documentation updates.
• The Knowledge Base, a large collection of product tips and workarounds.
• Examples and Utilities, including demos and additional product documentation.

To connect, enter http://www.microfocus.com in your browser to go to the Micro Focus home page.

Note: Some information may be available only to customers who have maintenance agreements.

If you obtained this product directly from Micro Focus, contact us as described on the Micro Focus Web
site, www.microfocus.com. If you obtained the product from another source, such as an authorized
distributor, contact them for help first. If they are unable to help, contact us.

Information We Need
However you contact us, please try to include the information below, if you have it. The more information
you can give, the better Micro Focus SupportLine can help you. But if you don't know all the answers, or
you think some are irrelevant to your problem, please give whatever information you have.

• The name and version number of all products that you think might be causing a problem.
• Your computer make and model.
• Your operating system version number and details of any networking software you are using.
• The amount of memory in your computer.
• The relevant page reference or section in the documentation.
• Your serial number. To find out these numbers, look in the subject line and body of your Electronic

Product Delivery Notice email that you received from Micro Focus.

On Windows, if you are reporting a protection violation you might be asked to provide a dump ( .dmp) file.
To produce a dump file you use the Unexpected Error dialog box that is displayed when a protection
violation occurs. Unless requested by Micro Focus SupportLine, leave the dump setting as Normal
(recommended), click Dump, then specify a location and name for the dump file. Once the dump file has
been written you can email it to Micro Focus SupportLine.

Alternatively, you might be asked to provide a log file created by the Consolidated Tracing Facility (CTF) - a
tracing infrastructure that enables you to quickly and easily produce diagnostic information detailing the
operation of a number of Micro Focus software components.

On UNIX, you can use the Micro Focus UNIX Support Scan Utility, mfsupport, to create a log file that
contains the details about your environment, product, and settings. The mfsupport script is stored in
$COBDIR/bin.

To run mfsupport:

1. Start a UNIX shell.
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2. Set COBDIR to the product with issues.
3. Execute mfsupport from a directory where you have write permissions.

This creates a log file, mfpoll.txt, in that directory.
4. When the script finishes, send the mfpoll.txt file to your Micro Focus SupportLine representative.

Note:

If COBDIR is set to a location that does not contain etc/cobver, the script outputs the contents
of /opt/microfocus/logs/MicroFocusProductRegistry.dat which keeps a list of the
installed Micro Focus products.

Creating Debug Files
If you encounter an error when compiling a program that requires you to contact Micro Focus SupportLine,
your support representative might request that you provide additional debug files (as well as source and
data files) to help us determine the cause of the problem. If so, they will advise you how to create them.
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Disclaimer
This software is provided "as is" without warranty of any kind. Micro Focus disclaims all warranties, either
express or implied, including the warranties of merchantability and fitness for a particular purpose. In no
event shall Micro Focus or its suppliers be liable for any damages whatsoever including direct, indirect,
incidental, consequential, loss of business profits or special damages, even if Micro Focus or its suppliers
have been advised of the possibility of such damages. Some states do not allow the exclusion or limitation
of liability for consequential or incidental damages so the foregoing limitation may not apply.

Micro Focus is a registered trademark.

Copyright © Micro Focus 1984-2014. All rights reserved.
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